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INTERNATIONAL COMPUTER SERVICE 

EOFY 2025 NEWSLETTER 

 

  
 

   

 

 

A M - W I N  

NEW AM-WIN  
iOS APPS VERSION! 

AM-Win iOS Apps  
Version 2.8.1 

is now available!  
 

If your SUA is up to date 
contact ICS for assistance! 

 

Find out more about Version 11 
in the AM-Win sections  

of the newsletter. 

E N D  O F  F I N A N C I A L  Y E A R  

READY FOR EOFY?! 
End of Financial Year is 

quickly approaching! 
Please read the  

AM-Win EOFY guide well before 
June 30th as there are many 

steps to consider leading up to 
the financial year processing. 

Find out more about EOFY in the 
AM-Win sections of the 

newsletter. 
 

L I G H T N I N G  P A Y R O L L  

EOFY IS EASY  
WITH LIGHTNING!  

 

Please follow our  
Step-by-Step guide  

for EOFY and for renewing your 
Machine Credentials. 
Find out more in the  

Lightning Payroll Integration 
section of the newsletter. 

 

If you have any queries about any of the 
content in this newsletter,  
or any general enquires, contact ICS: 

(07) 3107 1923 

support@icsjet.com.au 

http://www.icsjet.com.au/contact/ 

or find us on Facebook!  

mailto:support@icsjet.com.au
http://www.icsjet.com.au/contact/
https://www.facebook.com/InternationalComputerService/
https://www.facebook.com/InternationalComputerService/


 26/06/2025 

 

ICS Newsletter 2 
 

END OF FINANCIAL YEAR WITH LIGHTNING PAYROLL! 
 
 
 
 
 
 
 
 
 

Since our transition with Lightning Payroll, the EOFY payroll process is easy. 
 

Please follow our step-by-step guide below. 
https://www.amonline.com.au:/HelpOnline/Level3/ViewTopic/9368 

 
If you require assistance during this process, you can contact the ICS or Lightning support teams, email 

support@icsjet.com.au or support@lightningpayroll.com.au and a support ticket will be lodged for you. 
 

It is recommended you start reconciling your payroll now! 
 

 
See below for Lightning’s 2025 End of Financial Year Checklist. It contains everything you need to know 

about reporting end of year figures to the ATO, troubleshooting and more.  

What’s included in the EOFY Checklist: 

•  How to finalise STP for the year with step-by-step guidance 

•  Clarification on processed dates vs pay period 

•  Super increase to 12% from July 1st, 2025 

•  Tax table updates and version info 

•  Premium one-on-one EOFY training sessions 

•  How to handle payment summaries 

•  Contact info for EOFY support 

 

https://www.amonline.com.au/HelpOnline/Level3/ViewTopic/9368
mailto:support@icsjet.com.au
mailto:support@lightningpayroll.com.au
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✅ EOFY PAYROLL: ALL YOU NEED TO DO 

Simple Steps for Finalising the Year in Lightning Payroll: 

• When lodging your final Single Touch Payroll of the financial year, tick the box marked ‘Final pay 
for the financial year?’. The first submission for this pay run will be a new/pay event. 

• At EOFY we always recommend lodging a second STP submission as an update 
event immediately afterwards. Make sure to again tick the box that says ‘Final pay for the 

financial year?’. 

 This two-step approach helps prevent the most common EOFY errors. 

 

📆📆 IT’S ALL ABOUT THE PROCESSED DATE 

As the ATO explains here: 

• With regards to financial years, it is not the pay period but the date of payment that matters. 

• A pay run processed and paid on 1 July belongs entirely to the new financial year, even if the pay 
period ends on 30 June. 

• Make sure you finalise the 24/25 financial year in the final pay run processed in June. 

•  Processed dates are critical – don’t get caught out! 

 

https://email.lightningpayroll.com.au/t/j-l-wdjjjo-l-y/
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 SUPER RATE INCREASE TO 12% FROM JULY 1ST, 2025 

Starting 1 July 2025, the compulsory Superannuation Guarantee (SG) rate will increase from 11.5% 
to 12% as part of the legislated pathway toward stronger retirement savings. 

Lightning Payroll makes this easy — we’ll automatically adjust your employees’ super rates during their 
first or second July pay run (if applicable). If someone is already earning above the required SG rate, no 

change will be made. 

 Please double-check super rates after your first July pay.  
Some uncommon workflows (e.g. test pays in June using June dates) may prevent the automatic update. 

Newer versions of Lightning Payroll handle these better, but it’s always worth confirming. 

If needed, you can: 

• Manually update super under Tools >> Update Superannuation Guarantee Rates 

• Recalculate super on pays via Tools >> Recalculate Super On Pays 

• Or disable auto-checking under Employees >> Super >> Superannuation Contributions 

 

 UPDATE NOW FOR THE 2025/2026 TAX TABLES 

To ensure you're using the latest ATO rates for the new financial year, make sure your Lightning Payroll 
software is up to date. 

✅ Web and mobile users – you're already up to date! 
 Desktop users (Windows and Mac) – please check that you're running version 2026.3 or later. 

Here’s how: 

• Click ‘Check for Updates Now’ on the bottom toolbar of your Lightning Payroll app. 

• If that doesn’t work, you can reinstall the latest version manually using the download links below. 

 Reinstalling will not affect your payroll data – it’s a safe and easy way to get the latest updates. 

 What’s changed this year? 

Only the STSL (Study and Training Support Loans) tax tables and a few minor adjustments have been 
made for 2025/2026. The standard tax thresholds remain unchanged, so most employees will not see 

any difference in take-home pay. 

We’ve applied all the latest ATO changes as outlined here: 
 2025 PAYG Withholding Tax Tables – ATO 

 

Windows Download 

Mac Download 

 

 

 

https://email.lightningpayroll.com.au/t/j-l-wdjjjo-l-j/
https://email.lightningpayroll.com.au/t/j-l-wdjjjo-l-t/
https://email.lightningpayroll.com.au/t/j-l-wdjjjo-l-i/
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 EOFY REFRESHER TRAINING – ONE-ON-ONE SUPPORT 

Need peace of mind closing out the financial year? 

Lightning’s standard support remains 100% free and available if you need quick help. 

But if you'd like more focused assistance, they’re also offering  
dedicated one-hour EOFY training sessions – a premium service designed to give you tailored, 

uninterrupted support with one of our payroll specialists. 

During your private session, they’ll: 

• ✅ Guide you through running key reports 

• ✅ Check over your pay runs for common issues 

• ✅ Walk you step-by-step through the STP finalisation process 

 Perfect if you want a professional check-up before submitting your EOFY reports with confidence. 

 Learn more about what’s included in a session 

Book Now 

 

 STILL NEED PAYMENT SUMMARIES? 

Even though STP finalisation has replaced the need to distribute traditional group certificates,  
you can still generate PAYG Payment Summaries in Lightning Payroll  

for your records or for employees who request them. 

It’s easy: 

1. Go to the End of Year section in Lightning Payroll. 

2. Select the relevant financial year. 

3. Follow the on-screen prompts to print or email the summaries. 

 Full instructions in our FAQ 

 Note: There’s no longer any need to lodge these with the ATO if you’re using STP,  
but you can still provide them to employees for reference. 

 

 EOFY Help, When You Need It 

Whether you're finalising a single pay run or wrapping up a full year of payroll, Lightning’s friendly support 
team is here to help you every step of the way. 

 Call them on: (07) 3051 5895 
 Email: support@lightningpayroll.com.au 

Let’s close this year strong with clean books, correct submissions, and confidence. 

 Lightning Payroll, helping Aussie businesses do payroll right! 
 

 

https://email.lightningpayroll.com.au/t/j-l-wdjjjo-l-d/
https://email.lightningpayroll.com.au/t/j-l-wdjjjo-l-h/
https://email.lightningpayroll.com.au/t/j-l-wdjjjo-l-k/
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Q: How Can I Renew My ATO Machine Credential for Lightning Payroll Desktop? 

Answer: 

Lightning Payroll desktop can connect with the ATO's machine credential renewal service. This allows you 
to easily renew machine credentials used for sending Single Touch Payroll through to the ATO. 

You can renew your credentials under Tools >> Renew Machine Credential. 

 

All you need to do is select the credential you wish to renew and click Attempt Renewal.  

Renewals are not guaranteed since it is outside of our control. You may need to create a new machine 
credential if a problem arises or if you have forgotten your ATO keystore password. 

To find out how to create a new machine credential, click here. 
To find out what to do if you have forgotten your machine credential keystore password, click here. 

 

 

https://www.lightningpayroll.com.au/faq?selected=188
https://www.lightningpayroll.com.au/faq?selected=209
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        END OF FINANCIAL YEAR IS COMING! 
   IMPORTANT INFORMATION 

 

Please read the AMWIN EOFY 25 guide well before June 30th as there are many steps to consider leading  
up to the financial year processing.  
Including: 

• For your Accountant - what reports they want and what they expect 
• Backing up your data (TWICE! At least one external backup!)  
• What to consider when looking at unfinalised jobs and the work in progress report 
• Unfinalised Orders 
• Bank reconciliation 
• Stocktake 
• Reconciling your Ledger control accounts to your aged analysis 
• Do I need to do a month end? 
• Final checks to perform before processing 
• Processing the year end 
• Back posting entries to the previous month 
• When you need to process your GST period 
• Closing off your GST period 
• Printing off your year-end reports 
• What reports to print 
• Optional reports 
• Deleting ledgers 
• Clearing financial details 
• Processing in the new financial year 
• The final checklist prior to processing. 

See the AMWIN EOFY 25 to view/print the EOY document. Please read this document, print it out 
and have it handy well before you perform your year-end process. 
  

  AM-WIN EOFY FAQs 
   END OF FINACIAL YEAR FREQUENTLY ASKED QUESTIONS 

 

In this section you will find answers to a few of our most Frequently Asked AM-Win Questions from the 
past month…      
 
BAD DEBT WRITE OFF 

AM-WIN – EOFY CHECK LIST 

DEPOSIT RECONCILIATION SCREEN 

AM-WIN END OF YEAR ON AMONLINE 
 

PLEASE DO NOT STOP YOUR END OF YEAR PROCESS  
IF YOU THINK IT IS TAKING TOO LONG.  

THE END OF YEAR PROCESS IS LONGER THAN THE END OF MONTH PROCESS.  
END OF YEAR PROCESS COULD BE ANYTHING FROM 10 MINUTES UP AN HOUR.  

PLEASE DO NOT STOP IT HALF WAY AS THAT WILL CAUSE MORE ISSUES. 
IF YOU BELIEVE SOMETHING HAS GONE WRONG  
OR YOU NEED ANY HELP PLEASE CONTACT ICS. 

 
PLEASE KEEP IN MIND THIS IS OUR BUSIEST TIME OF YEAR AND THERE MAY BE A SHORT DELAY IN THE 

CALL PERIOD. WE DO APOLOGISE FOR ANY DELAY BUT WILL HELP YOU AS SOON AS POSSIBLE. 
 

 

https://amonline.com.au/FAQ/FAQItem/ViewTopic/58
https://amonline.com.au/FAQ/FAQItem/ViewTopic/58
https://www.amonline.com.au/FAQ/FAQItem/ViewTopic/176
https://www.amonline.com.au/FAQ/FAQItem/ViewTopic/176
https://www.amonline.com.au/FAQ/FAQItem/ViewTopic/43
https://www.amonline.com.au/FAQ/FAQItem/ViewTopic/43
https://www.amonline.com.au/HelpOnline/Level3/ViewTopic/8991
https://www.amonline.com.au/HelpOnline/Level3/ViewTopic/8991
mailto:support@icsjet.com.au
https://icsjet.com.au/download/am-win-eofy-checklist/
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AM-WIN EOFY TIPS 
EOFY ENQUIRY SCREEN TIP 

 
Remember! Once you have rolled AM-Win into the new financial year, the enquiry screen will now be 

showing, by default, only the new year’s transactions. If you haven’t done any transaction this year you will 
even get a No Records Found message. 

 

 
 

To view previous years’ transactions, make sure you select the Show All or Prev Year  
and select year and a particular month if required.   

If you don’t select a month the entries for the entire financial year will be shown. 
 

 
 

and then hit F5 or the Refresh button. 
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USEFUL EOFY AM-WIN FEATURES 
STOCK DATA TOOL 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Every year businesses are looking to reduce tax and one of the best ways to do this is to write-off your dead 

stock. This can be a time-consuming process, but AM-Win has you covered. 
 

The AM-Win Stock Data Tool Module is a powerful tool which allows you to manipulate your Stock File in a 
variety of ways including creating a list of Dead Stock that hasn’t been sold for a time that you nominate and 

then allowing you to write-off the value to a chosen expense account. 
You can also use the Tool for many other things from setting Prices, changing Descriptions, 

moving Parts between and in and out of Stock Groups and Subgroups, 
changing preferred Suppliers to many other features. 

This Tool provides a great deal of power for you to make your Stock File much more efficient  
and for it to start working for you rather than against you. 

 
The Stock Data Tool is not a standard AM-Win module. This Additional Module can be added to your Package 

quickly and easily and a technician would guide you through the many uses for this Tool. 
 
 

See more about the Stock Data Tool on the AM-Win Online Education Centre. 
 
 

 
 
 
 
 

WANT A DEMO? 

 
Contact the ICS team now on 07 3107 1923 or at support@icsjet.com.au to arrange a demo and find out 

how it can improve the efficiency of your business. 
 

 
 

https://www.amonline.com.au/HelpOnline/Level3/ViewTopic/8355
https://www.amonline.com.au/HelpOnline/Level3/ViewTopic/8878
mailto:support@icsjet.com.au
https://www.amonline.com.au/HelpOnline/Level3/ViewTopic/8878
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  AM-WIN EOFY FAQ 
STHIS MONTH’S MOST FREQUENTLY ASKED AM-WIN QUESTIONS 

 
Question:  Once I have rolled the Year over in AM-Win, can I still post to Last Year? 
                    
Answer: Yes, you can do your End of Year rollover and then still be able to back-post        
                  transactions into June as long as you don’t close your GST. 
 

1. Roll the year using the usual month rollover procedure.  
(Ledger > GST End of Month/Year > End of Month/Year.  
See End of Year Rollover document for details) 

2. The system will do a backup, then show you the screen below 
3. Select “No” to the question highlighted below to keep your GST open 

This will keep June open for 1 month until you roll into August,  
at which point it will ask you to close the GST. 

Note: whether you close your GST or not, Journal Entries can still be back posted  
into any month in the previous financial year 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Then when processing invoices/orders etc from last month you will be asked  
“Do you wish to post to LAST Month?” at which point you can press Yes. 
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Question:  Can I change a Part Number on a Finalised Invoice? 
                    
Answer:    Yes! You can now change the part number on a finalised invoice instead of cloning, 

deleting, and re-finalising the invoice.  
 
From the Customer History screen right click on the part number you wish to change 
and select the Part Change option. 
 
You can change the item which will update the invoice and also correct the stock on 
hand figures for the old and new item.  
 
You are not able to change the price or quantity supplied. The system will account for 
the difference in average cost between the items. 
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Question:  I made a mistake and, in an attempt to fix that mistake, I made several more.  
Now if I send this customer a statement it will show the invoice, a credit, a payment, a 
reverse payment and several other transactions I made to correct my mistake, which 
can be confusing for the customer. 
 
How do I hide these extra transactions so the customer only sees what they need to 
on the statement? 

 
Answer:    AM-Win has added the feature in the Enquires window that allows you to Right  

Click on a transaction and hide it so it won’t appear on the Customer’s Statement.  
NOTE: The transactions you wish to hide must add up to zero. 
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AMONLINE TOP PAGE OF THE MONTH 
 
 
 
 

 
 

 

 

STOCKTAKE OPTIONS 
 

There are numerous options available to process a stocktake using AM-Win. These options depend on 
the size of your business, the type of stocktake you wish to perform, how many items of stock you 
carry, how many stock locations or departments you have, along with many other circumstances. 
  
Below are a number of options that can be used depending on the type of stocktake you wish to 
perform. 

STOCKTAKE BATCH 

The Stocktake Batch allows you to process stocktaking by batches. This means that you can process a 
stocktake using a large criterion of filters such as bin location, supplier, stock group etc. You can also do a 
stocktake for a range of parts by location and between two parts numbers alphanumerically. 
  
Once the batch is saved you can then print batch stocktake reports and count the actual stock on hand. Once 
the stock is counted you are then able to enter the discrepancies and process the stocktake. 
  
One of the main features of the stocktake module is that once the stock is counted you can take as long as 
you like to update the batch on the computer and AM-Win will account for any sales or purchases that have 
been done since the items were counted. 
  
To open the Stocktake Module, in the main AM-Win program to go Stock > Stocktake > Stocktake Batch. 

 
Note: This help page also includes information on processing a serialised stocktake, with help specific to 
serialised stock coloured in green. If you wish to process a stocktake for serialised stock then you must use 
the Stocktake - Serialised option. 
  

https://www.amonline.com.au/HelpOnline/Level3/ViewTopic/8355
https://amonline.com.au/html/STOCK/STOCKTAKE/Stocktake_-_Serialised.htm
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Creating a New Batch 
The first step in the stocktake process is to begin a new batch. This allows you to create a batch, which can 
then be printed, counted and processed. To create a new batch click on the New button. You are then able to 
create a stocktake by a single filter or by multiple filters. Firstly, we will start with a single criteria. 
  
Select Single 
Select the criteria you want to use from All, Bin, Group, Sub Group or Supplier. You can also Import a 
CSV file. 
  
You can then select the stock class from the Stockclass drop-down to be included either by "All", "Stock", 
"Consignment" or "Trade-In". You are not able to do a stocktake or non-stock or revenue items. If you wish 
to change the on hand quantity of a non-stock item, you can change the quantity directly from the Stock 
Masterfiles. 
  
You can then select the Sort order to list entries by either "Bin", "Group", "No Group" "Stockcode" or "Bin - 
Stockcode". However, the report is printed in Bin location followed by part number order ("Bin - Stockcode"). 
  
All Type 
If All type is chosen then you can select a range of parts to be in the batch by part number. Firstly click on 
the From Part button and select the first part to be added to the batch. Then click on the To Part button 
and select the last part to be added to the batch. 
  
Bin Type 
If the Bin type is chosen then you can select a range of parts to be in the batch by bin location. The system 
will then load the bin location list which may take a few seconds. Firstly select the From Bin list and select 
the first Bin to be added to the batch. Then select the To Bin list and select the last Bin location to be added 
to the batch. 
  
 
 

https://amonline.com.au/html/STOCK/STOCK_MASTERFILES/Stock_Masterfile.htm
https://amonline.com.au/html/STOCK/STOCK_MASTERFILES/Stock_Masterfile.htm
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Group Type 
If Group type is chosen then you can select a range of parts to be in the batch by the Group. Firstly click on 
the Group button and select the group. 
  
Supplier Type 
If Supplier type is chosen then you can select a range of parts to be in the batch based on the Preferred 
Supplier. Firstly click on the Supplier button and select the supplier. 
  
Inserting Single Items 
The system will also allow you to insert single items into the batch as long as these items do not already 
appear on other batches or in fact are already on the existing batch. Click on the Insert Part button and 
select the parts to be added from the **Parts Link screen. This will then add the selected items into the 
batch. 
  
Select Multi 
You may wish to generate a batch using multiple criteria at the same time under the options available in 
the Select Multi tab. Click on the Select Multi tab which then changes your filter options. You are now able 
to select a range of parts to be included in the stocktake by a combination of filters. 
  
You are able to select within a certain supplier and within a group and also within a sub group as well as 
within a certain bin location range. If left blank then this means all of that type will be used. Eg, if supplier is 
left blank then the system ignores who the supplier is when generating the batch. 
  
If you use all filters then only parts for the selected supplier, within the selected group and sub group and 
also within the bin location range will be placed in the batch. This can generate rather small and very specific 
stocktake batches. Remember that when you click the Generate button to generate the batch, only parts 
that are within the filter ranges and also that are not already on another batch will be added to the batch. 
  
Filter Options 
There are a number of tick boxes that enable you to filter the records based on a number of criteria as 
follows: 
  
Ignore Zero Stock - This option will ignore any items that have a stock on hand of 0. This will save you 
trying to count stock that doesn't exist and you may not have purchased for a long time. One issue with this 
option is that you may fail to count stock which is on hand but excluded because the system shows the stock 
as having 0 on hand. 
  
Only Negative Stock - If your stock is generally under control with a few negative items, you may wish to 
tick this box so that only stock with a negative quantity on hand is generated into the batch. 
  
Active Stock Only - This option will only bring active stock into the stocktake. Stock that has been marked 
Inactive or basically redundant will not be added to the batch. 
  
Include Issued Stock - It is often difficult to do a stocktake when you have work in progress as some of 
the stock may be removed from the shelf and fitted to the job. In this case, you can mark the stock as 
"Issued" to the Job or Customer Order so that the system knows not to count the stock. If you tick this 
option the system will assume you are only counting what is on the shelf and excluding from the count 
anything that is issued to a Job or Customer Order. If the option is not ticked then the system assumes your 
counted quantity also includes these items. 
  
Generating a Batch 
You can then click on the Generate button and the screen will be filled with all parts within the range chosen 
unless those parts are already in another batch. An item can only exist in one batch at a time for each 
location to avoid it being counted twice. 
  
If you are processing a serialised stocktake, then two additional columns will appear on the right of the list 
box showing details of the serial numbers and status of the serial number against each item as you click on 
the item. 
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Multiple selections 
Multiple types can be used to generate a single batch. For example you may choose a specific supplier and 
then Generate the batch, and then also choose a certain Group and then generate additional items into the 
batch. 
  
Importing into a batch 
You are able to create a CSV file via Excel or some other method and import this file into the stocktake batch. 
The file format needs to have the Part Number or Barcode in the first column, and the Quantity Counted in 
the second column. 
  
If you have saved the file as an Excel format and are ready to import into the Stocktake in AM-Win, you need 
to change the file to a CSV format. To do this, in Excel click on File > Save As. Choose a location, then 
below the name of the file change the Save As Type to be CSV (Comma Delimited) (*.csv) 
  
You can also use Notepad or some other editor to create the file. A CSV file must have a comma between the 
part number/barcode and the quantity. If the part number contains a comma (unusual), then this will cause 
an issue when trying to import the file. 
  
Note: If you need to make any changes to this file after you've saved it, open the Excel file and make the 
changes, NOT the CSV file as any leading 0s on a part number or barcode will be removed from the file. 
  
To import this stocktake file into AM-Win and process the stocktake, in the Stocktake Module under 
the Select Single tab choose the Import option, then click on the Import button and select the CSV file 
you have saved. This will then drop the parts and the new counted quantities into the stocktake screen. 
  
Note: If you get the error message "Access Denied", close the stocktake file in Excel and try again, as AM-
Win cannot open the file if you already have it open somewhere else. 
  
Click Save to save this stocktake batch, then follow the steps below to update records as needed, print a 
variance report and finalise the stocktake. 
  
Part Entry 
This tab allows you to insert items into the stocktake batch that have already been counted but not currently 
on the batch. During the stocktake you might find additional items that you count that were not on the batch 
which have been done manually and have to be accounted for. This tab allows you to select the stock item 
and then enter a quantity that was counted, which will then be appended to the batch once you click 
the Add button. 
  
Save 
After generating the batch and adding all of the items required for the batch, you can click on 
the Save button to save the batch prior to either counting, exporting or printing a batch. 
  
Once the batch is saved the system will record the batch number and date of the batch in the Stock 
Masterfiles. If a batch number exists on the item then the system knows that item is allocated to a batch and 
will not be placed on another batch. When a batch is deleted or an item on the batch is finalised, the batch 
number is removed from that item and it can then be used in another batch. 
  
Import / Export 
After creating a batch you can then export the batch out to a CSV file, which can be accessed from Excel, 
Notepad or some other program. You can then update the file with the quantity that was counted using a 
laptop or other device. Once the counted quantity has been updated you can then import the file back into 
the batch to update the counted quantity. The Export / Import option is not available until a batch has been 
saved. 
  
Note: If you have exported a batch and wish to import the counted batch back in, you must do it through 
the Export / Import tab after revising the batch, and NOT through the Import option under the Select 
Single tab. 
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Batch Report 
Once the batch is generated you can save and print the stocktake sheet by clicking on the Sav-Print Button. 
This will save the batch and generate a batch stocktake report. 
  
The report allows you to Ignore Zero Quantities in the variance which will only display items where the 
stock on hand varies from the reported quantity. You should only tick this option to print a variance report. 
  
You also have the option Don't Print Quantity which will leave the quantity figure blank on the report. You 
may wish to do this so that when the count is being performed the person counting the stock doesn't just 
assume that the quantity reported is the quantity on hand. If someone is a bit lazy and counting items where 
there are many in stock they may not count them properly. 
  
Counting the Stock 
Once the batch has been created and saved and you have printed the stocktake sheets, you should now 
count the stock. The stock should be counted relating to the batch as soon as the batch is created so that 
stock is not removed from the shelf between the report being generated and the time the stock is counted. 
Once the stock is counted, you can update the count in the system within a reasonable time of the stock 
being counted. The system will take into account stock that is sold or purchased since the batch was created 
and allow for that in the stock adjustment. You can then revise the batch to update the counted quantity. 
  
See Stock Allocation. for information on how Unallocated, Reserved or Issued stock will affect the stocktake. 
  
Revising a Batch 
Once a New Stocktake Batch has been generated, you can then revise the batch to view or update it. 

 
  
To revise a batch, go into the Stocktake Batch screen under the Stock > Stocktake > Stocktake menu 
option and then click on the Revise button. You are then provided with a list of batches to choose from. 
Normally the batch number would be located on the report you printed for that batch. Once the batch is 
selected the parts on that batch will be displayed in the screen. 
  

https://amonline.com.au/html/Common_Topics/Stock/Stock_Allocation.htm
https://amonline.com.au/html/STOCK/STOCKTAKE/Stocktake_Module.htm#Processing_the_Batch
https://amonline.com.au/html/STOCK/STOCKTAKE/Stocktake_Module.htm#Printing_the_Variance_Report
https://amonline.com.au/html/STOCK/STOCKTAKE/Stocktake_Module.htm#Updating_the_Records
https://amonline.com.au/html/STOCK/STOCKTAKE/Stocktake_Module.htm#Revise_Types
https://amonline.com.au/html/STOCK/STOCKTAKE/Stocktake_Module.htm#Deleting_a_Batch
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There are 4 different Revise Types which filter the information to be displayed. These include All, 
Active,Completed and Tagged. The default when revising a batch is Active. 
  
All - Displays all items in the batch regardless of the status of the items. 
Active - Displays only the items which are on the batch and have not yet been processed. 
Completed - Displays only those records in the batch that have been counted and processed. 
Tagged - Displays all records in the batch that are currently tagged and counted ready for processing. 
  
Updating the Records 
Now that the batch details are on the screen you are able to update the "Active" items and process the 
stocktake. Firstly, click on the Entered Operator button and select the person who is updating the records. 
Then click on the Counted Operator button and select the staff member who was responsible for counting 
the items. If you do not update the Operators, the system will force you to do so before updating the counted 
quantity for any of the items. 
  
Highlight the record to be changed and press the Enter Key. Enter the counted quantity and then press 
the Enter Key again. The item will be changed and the next item will be automatically selected ready for 
that item to be process by again using the Enter key. These items are then tagged with a green tick ready to 
be processed. If an item is tagged and you wish to untag it you can do so by   right-clicking on the selected 
item and then selecting the option to Untag the record. You can also Delete, Delete All Selected items 
that have been tagged but not processed, Show Stock in the Stock Masterfiles, Tag All or Untag All items 
when right-clicking. 
  
If you are using Serialised Stocktake and modifying the quantity, the system will open the Serial Number 
window. You will need to Insert or Delete serial numbers within this window to match the number of items 
that have been counted. If the original quantity was 5 and only 4 were found, you will need to delete one of 
the serial numbers so that only 4 numbers remain on hand. If you found additional items you will need to 
insert serial numbers to match those items. 
  
If an item was originally not serialised and you wish to make it a serialised item, you must first zero the stock 
by doing a stocktake of the item, and then do a serialised stocktake to bring those items into stock and 
allocate serial numbers to them. You can also do this through the !!Make Stock Serialised function in AM-Win 
Tools. 
  
You can also tag the item as counted by clicking the Toggle button. This assumes that the counted quantity 
agrees with the reported quantity. 
  
Items that are manually added onto the stocktake report which were not included in the batch can be 
manually inserted using the Insert Part button. Click on the button and select the item required and this 
item will be added to the batch as long as this item is not already active on another batch. 
  
Now that you have changed and tagged the records to be processed, you can then click on the Tag 
All button to tag the remaining unchanged records. This is because there may be say 200 items in the batch 
but only 20 of them need to be changed. Firstly, you can update/tag the 20 records that have changed and 
then click the Tag All button to tag the remaining unchanged records for processing and colour them in 
yellow, unlike other tagged records that are tagged in red. Even unchanged records need to be processed so 
that they can be marked as completed and then be available in the future for new stocktake batches. 
  
If you wish to untag all of the items that were automatically tagged (coloured in yellow) using the Tag 
All button you can click the same button again to Untag All items that were tagged. The Untag All button 
will only untag items that were tagged using the Tag All button. Items that were updated using 
the Enter key or Toggle button will not be untagged. 
  
At any time you can click on the Save button to save a batch in the middle of processing the stocktake. 
Remember that although the physical count should be done immediately after the stocktake has been 
processed, the data entry to update the records can be done later as the system recognises sales and 
purchases that have been done since the stocktake batch was generated. 
  

https://amonline.com.au/html/STOCK/STOCK_MASTERFILES/Stock_Masterfile.htm
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Printing the Variance Report 
Once you have updated the records to be processed you can then print a variance report by clicking on 
the Print Variance button before processing the batch. This will print a report showing the $ value and 
percentage variance for each item as well as a total dollar value and percentage. This report can be done 
before or after the records have been processed, but you can only alter the stocktake figures prior to them 
being processed. You can use this report to quickly scan for any large discrepancies which you may wish to 
investigate further and modify the counted quantity if the additional items are found. 
  
You can print All items, Active items, only Completed items or only Tagged items by changing the 
report Print Type drop-down above the button. 
  
If you do not wish to print the counted quantity on the reports, you can tick the Do Not Print Counted 
Quantity option. 
  
Processing the Batch 
You should ensure that the Process Date is set to the date you wish to use. Once the records have been 
tagged and they are ready to be processed you can then click on the Process button to process the 
stocktake. This is when the stock on hand and accounting functions are actually recorded. After clicking the 
process button the system will default to processing the discrepancy ledger based on the Stock 
Discrepancy account set up in the Multi Location settings. If this has not been set up, the system will 
default the discrepancy to the 9010 ledger. You can manually change this if required. 
  
The stock is updated, the ledgers for stock and the discrepancy is adjusted, and the stock movement is 
recorded against the items. This stock movement can be accessed under the Stock Enquiry screen. 
  
After processing the batch, a report will be automatically printed showing all of the completed items from the 
batch. If the batch has been part-completed previously, the report will also include previously completed 
items. 
  
Once the records have been processed, they are marked as completed with a red "P" in the Tag column, and 
the batch number is removed from the stock masterfile so that the item can be used in future batches. 
  
If you are processing a serialised stocktake, the serial numbers of the items will be amended based on the 
changes made from the stocktake. 
  
Note: That if a part number has been deleted from the Masterfiles and is on a batch then the item will never 
be able to be completed as the stock no longer exists in the system. You will need to right-click and delete 
the item from the batch. 
  
Deleting a Batch 
Click the Revise button and select the batch to be deleted. Once selected you can then click on the Delete 
button and the system will delete the selected batch and remove the batch numbers from the stock 
masterfiles for each item. 
  
Note: A batch can only be deleted if: 
1. All of the items on that batch have been completed / processed, or 
2. None of the items on the batch have been processed. 
Otherwise you must tag and process the remaining items on the batch in order to release those items for 
future stocktake batches. 
  
Clear 
The Clear button clears the screen and allows you to begin a new batch or to revise an existing batch. 
  
Close 
The Close button closes the stocktake module. The X button at the top right corner of the screen will also do 
this. 
 
 

https://amonline.com.au/html/OTHERS/Maintenance/Setting_up_Locations.htm
https://amonline.com.au/html/STOCK/Sales_Enquiries.htm
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QUICK ONE-OFF STOCKTAKE 

You can do a stocktake for a single item from the Stock Masterfile’s screen using the Stocktake button 
if the option for this button is enabled in the Business Options > Stock Options tab >  
Enable Stocktake Button in Masterfile. 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
  
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

This button will allow a stock take on an individual stock item. After clicking the button, the stocktake 
window will appear, allowing you to record a quantity of stock on hand. The stocktake takes into 
consideration items that have been issued to a job or customer order, and as such when recording  
the stocktake quantity you should not count items that are currently issued to one of these 
documents. After clicking the Process button, the system will modify the on-hand quantity for the 
item and post a journal between the stock asset account and the discrepancy expense account 
(usually 9010). 

 
Note: This button will be greyed out unless the "Enable stocktake button on selected stock item 

in masterfile" check box is ticked in Business Options. 
 
 

Keep reading about the numerous Stocktake Options available in AM-Win on AMOnline! 
 
  
 
 
 
 

Manual Stocktake 
 
Importing A CSV File 
 
Using the iOS Stocktake app 

Manual Batch Stocktake 
 

Serialised Batch Stocktake 
 

Using A Mobile Data Terminal 

https://amonline.com.au/html/STOCK/STOCK_MASTERFILES/Stock_Masterfile.htm
https://amonline.com.au/html/OTHERS/Control_System/Business_Options.htm
https://amonline.com.au/html/OTHERS/Control_System/Business_Options.htm
https://amonline.com.au/HelpOnline/Level3/ViewTopic/8863
https://amonline.com.au/HelpOnline/Level3/ViewTopic/8863
https://amonline.com.au/HelpOnline/Level3/ViewTopic/8863
https://amonline.com.au/HelpOnline/Level3/ViewTopic/8863
https://amonline.com.au/HelpOnline/Level3/ViewTopic/9331
https://amonline.com.au/HelpOnline/Level3/ViewTopic/8863
https://amonline.com.au/HelpOnline/Level3/ViewTopic/8863
https://amonline.com.au/HelpOnline/Level3/ViewTopic/8969
https://amonline.com.au:/HelpOnline/Level3/ViewTopic/8863
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WHAT IS AM-WIN WORKING ON? 
 
 
 
 
 
 

XERO INTEGRATION 

 
 

AM-Win have been working on the integration between AM-Win and Xero  
and we are happy to announce it is finally complete. 

The integration is one-way from AM-Win into Xero. This means that any adjustments or changes that need to 
be made to invoices / purchases / payments etc. will need to take place in AM-Win and pushed to Xero. 

Deposits for jobs will be sent to Xero as prepayments and will then later need to be allocated both in AM-Win 
and Xero as there will be no invoice link in AM-Win to Xero to facilitate the link to the invoice.  

This is because the invoice could be processed several months later and also possibly in a  
different financial year or GST period. 

Debtors (Including debtor statements) will be managed in AM-Win as will creditors, stock control, debtor and 
creditor payments, till reconciliation will also be in AM-Win based on deposits, cash sales, POS sales etc. 

being AM-Win processes. Xero will only have 1 debtor for AM-Win purposes which will be an AM-Win debtor 
containing all AM-Win produced invoices and the total balance. AM-Win will manage individual debtors. 

Creditors will be the same. You may also have other debtors or creditors which are directly managed by Xero. 
This shouldn’t be a concern as statements, payments and other debtor management is handled by AM-Win. 

Creditor management, purchase orders and payments will be managed in the same way. 

Xero will be used to manage non inventory creditors (utilities, office supplies etc.). Xero can also manage all 
of your overheads, bank reconciliation, depreciation and loan accounts, fixed assets / liabilities, BAS and 

other general accounting functions. AM-Win does have a full accounting system build in which could be used 
for all you bank recs, bas and all other accounting functions if required. 

E-COMMERCE WEBSITE INTEGRATION 

 
 
 
 
 
 
 
 
 
 
 

 
AM-Win now integrates with numerous e-Commerce sites such as Neto, Woo Commerce, Shopify and  

AM-Win’s own Back to Base web portal. This allows your dealers or agents to place an order with you via 
your website and those orders will be directly placed into AM-Win. Prices and stock on hand can be uploaded 
from AM-Win into your website and sales from the website can be automatically uploaded into AM-Win ready 

to be picked and packed for the customer.  
We are constantly developing further integration between AM-Win and websites. 
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PODIUM INTEGRATION 

AM-Win is now integrated with Podium, a customer interaction platform designed to help 
businesses connect with customers through messaging, reviews, and feedback management. 

This integration enhances AM-Win's capabilities, allowing businesses to manage customer 
communication and interactions seamlessly across both platforms. 

Powered by AI, Podium is an all-in-one messaging platform 
to help your business stay connected with your customers with ease. 

● Alert your customers for vehicle pickups. ● Appointment confirmations ● Send out reminders 
 

 

STIHL INTEGRATION 

AM-Win has been selected as one of only a few organisations in Australia to be involved in their new pilot 
program to integrate our DMS software directly into Stihl via an API interface. 

This integration will allow the following: 
1. Order Placements from Stihl Website 

- This application will download all the new Online orders into SQL Server. 
- This program will keep running in the background and will download orders automatically. 

 
2. Online Order processing Tool 

- This application will show all the Online Orders in one place. 
- User can select all orders which are new in the list. 

- User can process the Orders into AM-Win. 
- After processing to AM-Win order will disappear from the list and will go to AM-Win. 

 
3. AM-Win updates 

- Stihl order will show in Orders screen in AM-Win. 
- User can set Order as Ready to Stihl online Website. 

- User can cancel the Order and it will update the Stihl online Website. 
- When user will finalise the Job it will send updates to Stihl Website that order is complete. 

 
4. Inventory Updates to Stihl Website 

 

 
 
 

YAMAHA INTEGRATION 

AM-Win are currently working on a full integration with Yamaha for the marine and motorcycle industries. 
This will be of great benefit to numerous customers we have who are Yamaha dealers. 

 
 
 

HUBSPOT & THRYV INTEGRATION 

AM-Win are currently investigating and working with a few clients on integration with  
popular CRM systems including Hubspot and Thryv. 
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POWER BI INTEGRATION 

AM-WIN & POWER BI 
 
 
 
 

AM-Win are partnering with Subset Analytics to provide a state-of-the-art reporting solution for AM-Win. 
Subset Analytics is offering a comprehensive suite of interactive Power BI reports,  

tailored specifically for AM-Win customers. 
 
 
 
 
 
 
 
 
 
 
 
 
 

WHAT IS POWER BI? 
Power BI is a powerful data visualisation tool from Microsoft that turns raw data into insightful, interactive 
reports and dashboards. Imagine having all your business data—sales figures, labour efficiency, financial 
metrics—brought together in one place, where you can easily explore and understand it through colourful 

charts, graphs, and maps. With Power BI, you can quickly identify trends, make informed decisions,  
and share your findings with others in a visually engaging way. 

Power BI makes data analysis accessible and effective, empowering you to see the big picture at a glance. 
The true magic of Power BI lies in its ability to present information from multiple perspectives. For instance, 
with a sales-over-time chart, you can easily navigate through different time frames—year, quarter, month, 
week, or day. By clicking on a customer name elsewhere on the page, the line chart filters to display only 

that customer's sales totals. This powerful filtering can be applied to various categories, such as salesperson, 
supplier, location, product, or any other category you can think of,  

allowing for a comprehensive and tailored view of your data. 
WHAT’S ON OFFER? 

The product will launch with Sales and Workshop Reports available, and these will be followed by other  
AM-Win-Data reports such as Management Overview, Spares, Marketing and Finance. Each report will include 
a dashboard showing key metrics over time like Total Sales or Invoiced hours, and calculated metrics such as 

Gross and Net Profit or Fitter Efficiency. Also included are comprehensive bonus systems for Sales and 
Workshop teams and Monthly Breakdowns and Job Detail pages  

so staff can delve deeper into their individual performance. 

HOW DOES IT WORK? 
James at Subset Analytics has developed a suite of Power BI reports that leverage AM-Win data. These 

reports are hosted on a managed, secure Microsoft framework and will be continuously improved in 
functionality and usability. Setup is straightforward: AM-Win will establish a data gateway on your server, 
and soon after, you’ll be provided an online link to access your reports. There is no connection fee, and the 

reports are available through a flexible, no-commitment monthly subscription. In the future we plan to 
introduce new features and expand connectivity to additional data sources, including Facebook, Google, and 

customer management systems, enhancing the value and insights provided by our reports. 
For more information or for access to example reports,  

contact James at james@subsetdata.com.au or 0427 444 114. 

mailto:james@subsetdata.com.au
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LIGHTNING PAYROLL INTEGRATION 

 

 

 

 

As part of our ongoing commitments to our customers and partnership with Lightning payroll,  
AM-Win has developed a Lightning interface link to AM-Win,  

which is available in the latest version of AM-Win and Lightning. 

NOTE: To be eligible for the Lightning > AM-Win link you must purchase Lightning Payroll through ICS.  
Please contact ICS if you are interested. 

Version 2026.0 of Lightning has now been released. Some of the changes are below: 
 

• TChanges made to STSL (study loan) tax tables for the 2025-26 financial year. Standard tax tables remain 
unchanged. 

• New direct entry ABA file regeneration tool added to the Tools menu.  
This will allow you to regenerate ABA files for super fund deposits or pays. 

• Temporary TFNs can now be used for SuperStream.  
This will allow you to register a super fund or pay a contribution for an employee who has not yet provided a TFN. 

The temporary TFN will be replaced with the actual TFN when it is provided. 
• Improvements made to SuperStream flow, to help prevent errors. 

 
Other minor bug fixes and improvements. In most cases, users will be prompted to update once they open Lightning.  
In cases where they have declined to update or they did not get prompted, the installer can be downloaded from the 

Lightning Payroll website which will update their program to have the confirmation messages. 
 
Please note that the Lightning Integration sends all pays marked as completed for the selected pay run. 
Learn more about lightning on their website or watch their videos on the YouTube Page: 
https://www.lightningpayroll.com.au/features        https://www.youtube.com/@LightningPayrollAustralia 

LIGHTNING 2025 PRICING STRUCTURE UPDATE 

We’ve been advised by Lightning Payroll that as of 1 January 2025 there has been a slight price 
increase to their Payroll Software Packages, the new Pricing is as follows: 

o Small - $299* 
Up to 5 employees & 10 companies 

 

o Medium -  $549* 
Up to 30 employees & 10 companies 

 

o Large -  $999* 
Up to 75 employees & 10 companies 

 

o Unlimited -  $1649* 
No employee limit - Up to 10 companies 

 

*Please note that these prices as far as we are aware are current for the remainder of the 2025 calendar 
year and do not include any integration fees that are charged directly from ICS for various features and 

support that are currently available to all of our payroll supported customers. 
 
 
 

 

mailto:support@icsjet.com.au?subject=Interested%20in%20Lightning%20Payroll
https://www.lightningpayroll.com.au/features
https://www.youtube.com/@LightningPayrollAustralia
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NEW AM-WIN IOS VERSION RELEASE 

AM-Win has recently released a new iOS version for the  
AMATWORK app to the AppStore, v2.8.1. 

  
This new version includes the following: 

  
AMATWORK APP 

Adding Checklists – users can now attach checklists to a job in the  
Workshop and OnSite modules. 

AMSTOCKTAKE APP 
Stocktake Module – when completing a batch stocktake (single, online, or offline)  

and updating stock qty, the error requesting for the Bin Loc  
to be updated has now been removed. 

 
NOTE: If you have enabled automatic updates to the device running AMAtWork, 

then that iOS device may have already received this update. 
 

You can check this by navigating to the Settings screen in the AMAtWork app,  
where the current version your device is running is displayed. 

 
If you do not have automatic updates enabled, then you can manually update your 

AMAtWork app by going to the AppStore > find the AMAtWork app and enter the app 
page > select the Update button. 

 

 

 

 
 
 
 

 

 



 26/06/2025 

 

ICS Newsletter 26 
 

ANDROID MOBILE APP 

After the success of the iOS applications in many businesses, AM-Win are developing an Android version. 

AM-Win have completed the workshop application for Android and are now working on other features of the 
application including job bookings, sales orders, add to bucket etc. 

The workshop version of the Android application is now available to users on the Google Play Store.  
All licenced iOS users will be able to use the Android version on their same licence. 

IOS STOCKTAKE APP 

AM-Win have finished developing a single-stocktake function for iOS  
and currently working on a batch-stocktake function as well as an Android version. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

mailto:support@icsjet.com.au?subject=Interested%20in%20the%20AM-Stocktaking%20App!
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TYRO INTEGRATION 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Contact the ICS team now on 07 3107 1923 or at support@icsjet.com.au to find out more about how  
Tyro works with AM-Win and how it can improve the efficiency of your business. 

mailto:support@icsjet.com.au
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P787C4T2TB94#y1

Click here to get started 

https://app.messagenet.com.au/registration/am-win?utm_source=amwin&utm_medium=email&utm_campaign=CA-641-MN-AU-CY22-Channels-AM_WIN_Campaign
https://app.messagenet.com.au/registration/am-win?utm_source=amwin&utm_medium=email&utm_campaign=CA-641-MN-AU-CY22-Channels-AM_WIN_Campaign
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Exclusive offer for our valued customers. 

 

KNOW SOMEONE WHO WOULD LOVE AM-WIN? 

Share the tools that have helped your business succeed! 

Earn $200 Credit for Every Referral. 

HOW TO REFER 

1.   Tell a Friend 

Tell your colleagues and industry connections about your experience with AM-Win. 

2.   Contact Us 

They can reach out to us by phone, email, or on our website, or if they prefer, we can 
contact them. Then they just need to mention your business name as their referrer. 

3.   You Get Rewarded 

Once they purchase AM-Win, you'l l  receive a $200 credit applied to your next AM-Win SUA. 

SHARE THE POWER OF AM-WIN WITH YOUR NETWORK! 

REWARD YOURSELF WHILE HELPING OTHERS SUCCEED! 
 
 
 
 
 
 

FREQUENTLY ASKED QUESTIONS 
Is there a limit to how many people I can refer?  

Absolutely not!  
Refer as many connections as you'd l ike and earn $200 for each successful referral. 

How do you track my referrals?  
When your referral contacts us, they'l l mention your business name. Our team records this 

information and credit your account accordingly. 
Can the credit be applied to any AM-Win product?  

The $200 credit is specifically for your AM-Win Software Update Agreement (SUA). 
Terms and  cond i t ions  app ly .  The $200 c red i t  w i l l  be  app l i ed  to  your  account  once  your  re fer ra l ' s  purchase  i s  conf i rmed.  
Cred i t s  can  on ly  be  used  toward  your  AM-Win  Sof tware  Update  Agreement  (SUA).  Re fer ra ls  must  ment ion your  bus iness  

name when they  contac t  us  v ia  phone,  ema i l ,  o r  our  webs i te  at  www. i cs je t . com.au/Home/Contact .  
 

 

P803C4T T 4#y

CLICK HERE TO 
REFER TODAY! 

mailto:support@icsjet.com.au?subject=AM-Win%20Referral
https://www.icsjet.com.au/Home/Contact
https://www.icsjet.com.au/Home/Contact
https://www.icsjet.com.au/Home/Contact
https://www.icsjet.com.au/Home/Contact
https://www.icsjet.com.au/Home/Contact
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HARDWARE 
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Are your computers slow? We can help! 

 

 

 

 
 

 

 

 

 

 

ICS offer great valued Hardware Packages for outright purchase or rental. 

 

 

 

 

 

 

ALL ICS HARDWARE PACKAGES INCLUDE: 

• Setup to ICS standards, inc. transfer of data, programs etc. from old hardware (where possible). 
This includes resetting up of e-mails and other personal settings where required. 

• Options for Anti-Virus and Anti-Malware to keep your new computers protected. 
• Business Grade Hardware with a 3-Year Warranty. 
• ICS also offer retail (home) options with 1 Year RTB Warranty. 

$20K instant asset write-off available for small biz  
Read More in the FAQs section  

 

 

mailto:sales@icsjet.com.au?subject=Interested%20in%20ICS%20Hardware%20Packages
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   TAX TIME FAQs 
  TAX TIME TIPS 

 

In this section you will find some handy tips related to tax time.       
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                              

$20K instant asset write-off  
available for small biz  

 
If you’re a small business owner, you may be 

able to claim an immediate deduction for 
eligible assets costing less than $20,000. 

 
Assets can be new or second hand and must 

be first used or installed ready for use between  
1 July 2024 and 30 June 2025. 

 
For more info and to check eligibility, 

visit www.ato.gov.au/instantassetwriteoff 
 

 
 

Small business owners:  
Do you know if you can claim a deduction for 
the business portion of assets you bought last 

financial year in your tax return? 

Rather than depreciate the cost over a longer 
time, you can use the instant asset write-off to 
claim for multiple assets, big or small, as long 
as they cost less than the threshold – including 

things like: 

Tools of your trade 

Gadgets and tech 

Furniture and storage 

Even vehicles! 

Different thresholds apply depending on when 
you first used or installed the asset. Check 

which rules apply to you at 
https://www.ato.gov.au/businesses-and-

organisations/income-deductions-and-
concessions/depreciation-and-capital-expenses-and-
allowances/simpler-depreciation-for-small-business  

 

End of financial year is coming… 

 
Now is the time to: 
Review your finances 

Chat with your accountant  
Check in on your pricing,  

expenses and goals  
Find out the tax deductions and concessions 

you can claim 
You don’t have to do it alone - we have a 

helpful checklist to guide you: 
https://business.gov.au/finance/yearly-financial-

tasks/end-of-financial-year-checklist  

 

 

https://www.ato.gov.au/instantassetwriteoff?fbclid=IwZXh0bgNhZW0CMTAAYnJpZBExWk9GeGIzbldPU2NnN1hLQwEeDvxFCkIUH2gv86gPkcMPQalkBahYff8W9jhmLXALym2u6VmlR6hvO8pXz-w_aem_O7t_NAoTGIoJctQp7m8Jvg
https://www.ato.gov.au/businesses-and-organisations/income-deductions-and-concessions/depreciation-and-capital-expenses-and-allowances/simpler-depreciation-for-small-business
https://www.ato.gov.au/businesses-and-organisations/income-deductions-and-concessions/depreciation-and-capital-expenses-and-allowances/simpler-depreciation-for-small-business
https://www.ato.gov.au/businesses-and-organisations/income-deductions-and-concessions/depreciation-and-capital-expenses-and-allowances/simpler-depreciation-for-small-business
https://www.ato.gov.au/businesses-and-organisations/income-deductions-and-concessions/depreciation-and-capital-expenses-and-allowances/simpler-depreciation-for-small-business
https://business.gov.au/finance/yearly-financial-tasks/end-of-financial-year-checklist
https://business.gov.au/finance/yearly-financial-tasks/end-of-financial-year-checklist
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         THE LATEST TAX TIME SCAMS TO WATCH OUT FOR 
If you have Facebook, we highly recommend following ICS for posts on everything from the latest Scams 
to watch out for, to AM-Win and general computing support. 
 
 
 
 
 
 
 
 
 
 

SCAM ALERT!  
 

Beware of tax time scams. 
The financial year has ended, 

which means scammers are just 
getting started. 

Scammers may pretend to be from 
myGov, Centrelink or the 

Australian Taxation Office. They 
may say you can get a tax time 

refund or bonus, or that you need 
to pay a debt. 

You can help reduce the risk of 
getting scammed at tax time by 
keeping track of key dates. This 

includes when refunds, debt 
repayments or lodgements are 

due. 
We’ve got more tips on how you 
can spot a scam on our website: 

https://www.servicesaustralia.gov.au
/how-scams-work  

 

 
Phishing is one of the most 

common and effective techniques 
used by cybercriminals to gain 

unauthorised access to a 
computer system or network. 

Once a victim engages with the 
malicious link or file, they may be 

prompted to provide personal 
details, or malware may run on 
their device to covertly retrieve 
this information. Cybercriminals 
may then use this information to 

steal money or goods, or leverage 
this information to access other 
accounts and systems of higher 

value. 
Australians are becoming more 
aware of techniques dependent 

on social engineering (like 
phishing) but more can be done 

to build resilience: 
Think twice before clicking on 

links from unsolicited 
correspondence 

Verify the legitimacy of 
suspicious messages with the 

source via their official website or 
verified contact information, 

particularly if it is a request to 
transfer money or supply 

sensitive information. Visit the 
entity’s website directly, rather 
than via links in emails, SMS or 

other messaging services 
Report unusual activity as 
quickly as possible to 

ReportCyber and Scamwatch 
Visit cyber.gov.au/threats/types-

threats/phishing for more. 
 

SCAM ALERT!  

 
 A scam text is going around 

asking you to “verify your postcode” 
to get a parcel. It’s fake — don’t 

click or reply. 
 

Delivery scam texts are on the rise 
and they’re getting trickier to spot. 
Don’t fall for it. If it feels off, trust 

your gut. 
 

Here’s how to stay scam-safe: 
 

 Track parcels safely in the 
AusPost app with legitimate 

notifications 
 

 Don’t click links from unknown 
numbers — even if it says ‘AusPost’ 

 
 Never enter personal or payment 

info via SMS 
 

 Report dodgy texts to 
scams@auspost.com.au 

 
 Delete the message after 
reporting – don’t reply 

 
Reminder: we’ll never ask for 

payment, personal info or address 
updates via text. Ever. 

 
 

 
 

Have you noticed unusual activity 
on your accounts? Don’t ignore it – 

it could be a sign that you’re a 
victim of cybercrime.  

 
Our ‘So you think you’ve been 

hacked’ tool helps you figure out if 
you’ve been compromised, and 
shows you what you can do to 

secure your accounts and devices. 
 

Find out more  
https://www.cyber.gov.au/report-

and-recover/so-you-think-you-have-
been-hacked  

https://www.facebook.com/atogovau?__cft__%5b0%5d=AZUmQp5iI-SfhRMLGwMYNK-BwfGGlpdinXsxA_g7eq5Hp4l-M795rs-53KP090T5vurD4WMtUF6pw0VC-2ArB7NCHx_pmoHwrF5QoFyREsnPXJTdpNyVcCwDc0fvdjLXUHbLCr41UuelXWK7gdo0tJjwImxSS3hXbxdLv9f_ba5X0VNFd5Lbki-Q16YnL1pluNg&__tn__=-%5dK-R
https://www.servicesaustralia.gov.au/how-scams-work
https://www.servicesaustralia.gov.au/how-scams-work
http://cyber.gov.au/threats/types-threats/phishing?fbclid=IwZXh0bgNhZW0CMTAAYnJpZBExWk9GeGIzbldPU2NnN1hLQwEeRFCIsG3e_d034vLj2Z9W3dHjP0NFYazD-EZWEnJLHEzFoARfH3MnOE9eMAI_aem_b3fQi50XjgmRpAhotVLGTQ
http://cyber.gov.au/threats/types-threats/phishing?fbclid=IwZXh0bgNhZW0CMTAAYnJpZBExWk9GeGIzbldPU2NnN1hLQwEeRFCIsG3e_d034vLj2Z9W3dHjP0NFYazD-EZWEnJLHEzFoARfH3MnOE9eMAI_aem_b3fQi50XjgmRpAhotVLGTQ
mailto:scams@auspost.com.au
mailto:scams@auspost.com.au
https://www.cyber.gov.au/report-and-recover/so-you-think-you-have-been-hacked
https://www.cyber.gov.au/report-and-recover/so-you-think-you-have-been-hacked
https://www.cyber.gov.au/report-and-recover/so-you-think-you-have-been-hacked
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COMEDIC RELIEF 
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AM-WIN END OF FINANCIAL YEAR PROCESS 
WHAT TO DO TO PREPARE FOR THE YEAR-END PROCESS 

SPEAK TO YOUR ACCOUNTANT  

Talk to your accountant about what reports they want and what they expect. Your accountant will charge 
you to prepare and finalise your financial figures and as such the more efficient you are and the easier you 
make it for your accountant, the less you will have to pay for his / her services.  
(Well that’s how it should be anyway).  

Your accountant will require certain reports such as balance sheets etc. Some accountants vary in the 
reports they expect and a discussion with them prior to ending your year may save you a lot of time and 
grief at a later stage. Your accountant should also be made aware of your chart of accounts in advance to 
ensure they are aware of what each account represents and where they need to place it on their system. 
Not all accountants would understand your terminology for what you call an account. 

BACKING UP YOUR DATA 

It is the responsibility of the user to ensure that you keep adequate backups of your software to avoid any 
data loss due to corruption, power failures, processing errors or any other event, which may cause the 
loss of data. 

Do 2 (two), or more than 1 Backup of your data just prior to processing the year end and ensure that 
these backups are done correctly and stored in a safe place e.g. keep one at the office and one at home.   

UNFINALISED JOBS 

Before processing your year end, you may wish to ensure that all of your work in progress has been finalised, or 
at least as much as possible is finalised to ensure your customers receive their bill and you get paid quicker. 
However, if you are in a position whereby expect that you have made a good profit for the year then you may 
wish to extend the unfinished jobs into the next tax period. This will reduce your tax liability for the current 
financial year. However, it will catch up with you next year. (Again, we don’t recommend this procedure.)  

PRINTING A REPORT  

To get a list of all un-finalised jobs, you can either print a Work in Progress Report  
from the Job Invoicing Screen. 
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Or, go to Reports Centre> Workshop > Jobs in progress.  

 

 

 

 

 

You are then asked for a date range in which to look for the un-finalised jobs  
e.g. 01/07/23 to 30/06/24. Make you selections the press on GO. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The report will provide you with all un-finalised jobs awaiting input from you.  Either they are jobs in 
progress not finished which you will carry into the new financial year, or jobs that have been forgotten 
about which you will need to finalise or jobs that were never started, which you will need to delete. 

UNFINALISED ORDERS 

Before processing your year end, you may wish to ensure that all of your orders in progress have been 
finalised, or at least as much as possible is finalised to ensure you can claim all valid expenses in the 
current financial year and as such reduce your tax liability. This will also ensure the maximum input 
credits for your GST. 
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REVIEWING PURCHASE ORDERS 

Go to the purchase orders screen to view all outstanding purchase orders. 

Go through them all one by one by using the review process above, so you can either Delete, Finalise or 
leave them if you are still waiting for goods & they will be carried over into the next financial year. 

 

 

 

 

 

 

 

 

 

 

 

 

BANK REC 

You should have been performing regular and accurate bank reconciliations and so reconciling prior to the 
end of the year should be the same simple process.    

If you have not, you have a tedious process to go through to ensure that your bank account statement 
matches what you have processed through the computer  

The most important thing is not to forget to process in your system, Bank charges, Loan Payments, Lease 
payments or any other direct debit, automatic payment which goes into or comes out of your bank 
account. As these only show on your Bank statement each month & you do not get a remittance posted to 
you each month to remind you, they can easily be forgotten. 

When you have completed your bank rec for June, please print 2 copies of your unreconciled 
entries.  Keep on for yourself and 1 for the accountant.  Once you start doing your bank rec for July 
onwards, the unreconciled entries cannot be reprinted as the entries will end up in the presented column 
from July onwards. 

STOCKTAKE 

Prior to processing the end of the year, you may wish to perform a stock take and update your stock 
records with the current on hand values. 
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RECONCILING YOUR LEDGER CONTROL ACCOUNTS  
TO YOUR AGED ANALYSIS  

This MUST be done and completed prior to year-end for both customers and suppliers! 

Check that your 2020 a/c matches your aged supplier list and your debtors aged analysis matches the 
1030. These figures should be the same. In the event that they are not then you have a few options. The 
best option is to track down the event/transaction that caused the out of balance to occur.  

1. The first step in doing this is to go the AMWTools program and select Check Trans Masterfile 
option from the Others menu. 
 

 

 

 

 

2. Select the customer option and click on the Process button.  
This will provide a list of any customers, which do not balance against the transactions for that 
customer.  

 

 

 

 

 

 

3. You can then print this list and investigate each entry.  
You should also do the same process for Suppliers. 

 

4. When you have the Customer and Suppliers out of balances corrected, you should then check the 
Ledgers.  If there were any Customers or Suppliers out of balance, then you would expect to see 
the 1030 and 2020 ledgers on the screen.  When you run the process for the Ledgers, there will be 
a ‘fix’ button available.  If this is selected the relevant ledgers displayed will be corrected, and if 
there is still an adjusting figure require to make the Trial Balance balance, then the system will 
automatically place the balancing figure into the 3020 ledger.   

 

5. Once this process is completed, you should recheck the 1030 Ledger against the Aged Customer 
Report and the 2020 ledger against the Aged Supplier Report.  If there is still a difference, a 
journal can be done to balance the Ledgers.  Generally, the 6020 Ledger would be used with the 
1030 Ledger to balance, and the 7020 Ledger would be used with the 2020 Ledger to balance. 

 

6. If you are unable to journal against these accounts then you must setup the General Ledger Masks 
under the Tools menu within AM-Win to provide you access to these accounts. 

 

7. Click on G/L Journal on the left-hand side of the screen and change the 1029 to 1030 and the 2021 
to 2022 to gain access.  Click on Save, then Close. 
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8. The next step is to print the Transaction-Audit report under the  
Reports Centre > Accounting > Transaction Audit and select the dates of 01/07/23 to 
30/06/24 and click on Print. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. This will display a list of any out of balance transactions that have occurred. 
 

 

 

 

 

 

PLEASE NOTE THIS SCREEN IS AN EXAMPLE ONLY; DO NOT FOLLOW FOR 
YOUR ENTRIES. 

AT THIS POINT IT WE SUGGEST TO CONTACT YOUR LOCAL SUPPORT PERSON FOR ASSISTANCE 
WITH THE OUT OF BALANCE ENTRIES. 

mailto:support@icsjet.com.au
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10.  You should also check that your 1040 (all stock held) account matches your stock average cost on 
the stock valuation report. The stock valuation report will give you qty x ave ex cost, for grand 
total ave cost value of stock.  
Go to the Report Centre > Stock> Valuation report to get this figure it is at the bottom of the 
last page. 

 

 

 

 

 

 

 

 

 
 

 

11.  In most cases due to negative stock, incorrect stocktaking, resetting of average costs etc these 
figures will not balance. In the event that they do not balance you should attempt to investigate 
why. However, in most cases this will be a very long and fruitless exercise. Once you have given up 
on this then transfer the out of balance amount from your 1040 or appropriate stock account to 
your 7020 cost of sales account where it should have gone in the first place.  
(Using your General ledger journal screen) 
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• Check that your Profit & Loss YTD figure equals your INCOME & EXPENSE figure at the end of your 
balance sheet.  These two figures should be the same. If this is not the case then you may have 
some corrupt or unbalanced entries.  

 

If this is the case contact ICS for further help, Data can be lost due to corruption, 
power failures, processing errors, hardware lockups, virus attacks or any other event.  

ICS will try to help your fix the problem but it is not guaranteed due to some of the 
instances above. 

ABOUT YEAR END 
The AM-Win will only allow you to process a year-end during the last month of the financial year, which in 
the case of Australia is June or March in New Zealand. At any other time, the system will only allow you to 
process a month end. 

One of the most frequently asked questions at the end of the financial year is quote:  
Do I also need to do a month end?  

The answer is NO as the system processes the usual month end entries during the year-end 
process as well as other entries, which are specific to year-end. 

BEFORE PROCESSING THE YEAR END 

FINAL CHECKS: 
 

1. Please ensure that prior to processing the year-end you are confident that you have performed the 
steps outlined previously in this document and that you are ready to continue. 

 

2. Make sure as stated previously before numerous times that you have made at least two backup 
copies of your data prior to processing year end.   

 
3. Note that the year-end process can only be run when no on else is currently in the AMWIN program 

or any other associated modules including History/ Bank Rec etc. If you attempt to process a year-
end with other modules open it is likely that your data will be corrupted. 

 

4. Ensure that you have not performed any other work in the current session of AMWIN. If you are 
unsure then exit out of AMWIN, redo your backups and then go back into AMWIN and proceed to 

run your End of Year. 
 

 
NOTE:  THE YEAR END PROCESS HAS A LOT 
OF WORK TO DO AND WILL TAKE LONGER 

THAN A NORMAL MONTH END 
  

mailto:support@icsjet.com.au
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ROLLING OVER YEAR END 

 

1. To run the Year End, select the Ledger> GST End of Month/Year > End of Month/Year option 
and the year-end processing window will appear automatically stating that you are running the 
year end process.  

 

 

 

 

 

 

 

 

 

This process will advise you it will update and roll forward your accounts from June to July. 

 
Please note that latest version of AM-Win automatically does a backup. If you 

do not have the latest version, please ensure you back up your data first. 

 

 

 

 

However, it would be expected of you that you have already done your own 
backups prior to getting to this stage. 

 

If you are currently a Lite or Level 1 user then you must also process your end 
of GST period at this time.  

Furthermore, if you are a monthly GST client and you have not already closed 
off your prior GST period then you will be required to do so before processing 

Year end.  

Please see notes below on how to close the GST period. 
 

If you are L2 or higher you can leave the BAS open and close it in July so any 
late documentation can still be back-posted to June. 
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2. Click on the continue button after selecting no on all of the options then to go to the next step, and 
an automatic backup will be performed. 

 

3. Ensure you have closed all files before running year-end. This is an opportune time to go around 
the office / workshop/ front counter and ensure that all computers are not logged into the AM-Win 
program or any of its modules eg History etc.  Continue onto the next step after checking. 

 

The following window may appear for you to print off your end of year reports. However, 
it is not advisable you will print off your end of year reports at this stage unless you are 

absolutely not back posting any entries into the previous financial year once the year has 
been closed. Therefore, it is better to cancel past this reports window and then print your 
end of year reports in a few weeks’ time when you have back posted any required entries.  

 

 

 

 

 

 

 

 

 

 

 

4. The next screen gives you the ability to print out a draft copy of your BAS during the year end 
process without actually having to close the BAS, if required.  
 
Please note: Once you are rolled into July if you back post any entries into June then your BAS 
figures on the EOY BAS Draft will no longer be accurate. 
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At this point the system will automatically process any standing journal entries 

process your Year-end, click on the process button, which will then begin the procedure. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the ‘Click here to Process’ button and the Year End Process will begin. 
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The following events will occur during the year-end process: 

 
Any ledger balances in account 4000 and above will bring forward a zero 

carried forward balance and the accumulative balance of all these 
accounts will be carried forward into the 3030 unappropriated profit 

account, any account below 4000 will have the balance carried into the 
new financial year. All year-to-date transactions will be moved back one 

financial year with zero transactions carried forward. This means that 
you can still print or do an inquiry on any ledger for any previous year. 

The system will then update the carried forward balance and aging for all 
customers & suppliers and reset the turnover figures to zero. The system 
will then process stock year to date and month to date figures to zero. 

The current month is set to July and the year-end date is forwarded one 
year and also the GST period is reset and both the purchase and invoice 

register is aged to the next period. 

 

 

 

 

 

 

 

 

 

 

 

The system will then display a message that the year-end has been successfully completed and 
advising you to close AMWIN and restart the program.  

At this point we would advise you to reboot your server after closing AMWIN.  

You are then ready to begin using AMWIN in the new financial year. 
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BACK POSTING ENTRIES INTO THE PREVIOUS MONTH 

There is a separate process for the GST period end and for the month end processing. 

The system allows the user to finalise the month end and then close the GST period (if the period is due to 
be closed) at any time until the next month end is processed.   

Until the GST period is closed you are able to back post invoices, purchases, cheques, journals 
etc. In fact, all transactions except for BAS payments and standing journals can be back posted 

to the previous month. 

To back post a transaction to the previous month, simply date the transaction with a previous month date. 

If the GST period has not been closed then the system will give you the option to post the transaction to 
last month. If you say YES then the transaction will be back posted.  

If you say “NO” then the transaction will be posted to the current month.  

 

 

* * NOTE: If you back post a transaction then you should 
reprint your monthly reports.  

Also note that you cannot reprint adjusted debtors / 
creditors list as at month end except through last month’s 
reports, then you will be able reprint the aged reports for 

June anytime in future months. 
 

 

 

 

In the event that you back post into a previous year there are 
several rules, which you be aware of. 

 

If you back post a asset, liability or capital account then the previous 
year will be adjusted by the value of the back posting and the carried 

forward for the same ledger account will be adjusted for the new 
financial year as you would expect. 

 

However, if you back post to a trading account between 4000 and 9999 
then the previous year balance for that account would be updated but 
only the 3030 unappropriated profit account will be updated in the new 

financial year. 
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WHEN YOU NEED TO CLOSE OFF YOUR GST PERIOD 

AMWIN allows you to close off your GST period separately to your month end.   
This gives you an extra few weeks to still back post any late Supplier invoices.   
The system sets a flag, which determines whether you need to do a month end or a GST period 
end for the current period.  

 

This screen shows your control file, which is where the BAS period is originally set up. Either you 
are on a Quarterly period or monthly period. This should have been determined when you first 
started using AMWIN 

If you are on a monthly GST period you must alternately do a month end and a GST period end.   

This means that you would not be able to do 2-month ends one after the other, unless you have 
done a GST period close in between and vice versa. 

If you are on a quarterly BAS then you must do a GST period end after every third month end.  

The GST period end must be done for the period, which ended at the last month end.  

For example, if your last month end was at the end of a GST period being, let’s say, March, then 
you need to close your GST period end by the end of April. The system will not allow you to 
close the month of April until the GST period is closed 
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CLOSING OFF THE GST PERIOD 

Go to Ledger > GST_End of Month/Year > End of GST Period 
 

 

 

 

 

 

 

 

The Business Activity statement screen will come up; check that the dates are correct for the 
GST period you are closing. These figures are a guideline only and will not change any ledger 
figures in the AMWIN program. You can change these figures manually. 

A document ID number can be filled in on the last page of your BAS statement so check that you 
have this information.   It is on the GST lodgement form that is sent from the TAXATION office. 

Note that your GST period must be closed prior to rolling from July to August.  This would 
generally be done anyway, as the payment is due at the ATO by this time anyway. 

A sample ‘Draft’ BAS follows: 
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You can add/change any figures manually by clicking into the box you want changed and over 
writing with your correct figure. 

Once you have entered all your figures or you are happy with the figures that are already there 
click on the NEXT button to go to the second page. Do the same for this screen and change any 
figures that are required. 

If you are using the Wages Entries in the AMWIN program or Lightning Payroll, these figures will 
be added automatically, if not you can add them in manually. 

Click on the Next button again to come to the last page: fill in the document ID number if you 
have it. If not, you can leave it blank. 

 

Click on the Process button to close of this GST period. 

 

You can then print off this DRAFT copy of your BAS report. 

After you have printed off this report the screen should say process complete restart the 
program.  Exit the AMWIN program & go back in. You have now completed closing off your BAS 
period. 

PRINTING YOUR END OF FINANCIAL YEAR REPORTS 

Once you have finished back posting back entries into the previous financial year you should 
then close your GST period to ensure that no further entries can be back posted. Once this is 
done you are then ready to print your end of year reports.  

WHAT REPORTS TO PRINT  

The following reports are generally considered essential as part of your end of financial year 
reporting. 

• Customer Aged analysis 

• Supplier Aged analysis 

• Trial Balance 

• Income Statement (very long report) 

• Balance Sheet 

• Invoice Register 

• Stock Valuation Report 

• Wage reports 
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OPTIONAL REPORTS  

The following reports maybe printed as part of your year-end reporting but are generally 
considered not essential unless you or your accountant require them specifically. 

• GST Report (if not intending to backpost) 

• BAS Report (if not intending to backpost) 

• Cash Bank Activity 

• Ledger Activity (very long report) 

• Customer Activity (very long report) 

• Supplier Activity (very long report) 

• Stock Sales by Group 

WHY NOT TO DELETE LEDGERS 

Please note if you delete an account which was used in a previous financial year but has a 
current zero balance which would be the case for income and expense accounts which have not 
been used in the current year then when printing or viewing reports for the previous years the 
reports will NOT balance because these ledger accounts no longer exist.  

As a result, it is recommended that you do not delete any ledger accounts but mark them as 
being suspended. Do this by changing the name of the ledger to unused plus changing your 
general ledger masks so that they do not come up in any screens when selecting the Revenue, 
journal and expense etc. buttons.  

CLEARING FINANCIAL DETAILS  

You would do this in the event that you have not carried forward accurate accounting figures and 
would like your system to start afresh in the new financial year. 

We do not like customers to run any AMWIN Utilities without assistance from an ICS 
technician as running the wrong utility could cause irreversible damage. 

The system can be told to clear all financial details using the AMWTools utility module.   

 

This process will reset your debtor, creditor, stock and ledger figures back to zero  
but retain your Job history & Master file details. You will then be able to re-enter the  
opening balances for your customers, suppliers, stock & ledgers. 

Please contact ICS if you wish to run this process and they will guide you through step-by-step 
or dial in if you have the facility and run it for you. 
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PROCESSING IN THE NEW FINANCIAL YEAR 

You are now ready to begin processing transactions for the new financial year.  
If you required to view or print reports for the previous year such as trial balance, sales & 
purchases etc etc , then you can do so by selecting the required year when printing or 
requesting such information.  
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THE FINAL CHECK LIST …. 

It is important that the knowledge you have learnt is followed and utilised to ensure that your 
year-end goes smoothly and you provide yourself and your accountant with the information 
required to efficiently process your figures.  

Remember these important steps. 

1. Contact your accountant to discuss what they will require from you in the way of reports 
and other financial records. It is this more than anything else that will save you money 
and time in the process of getting your financials processed.  

 

2. Ensure that you are up to date with your invoicing and purchasing and you have claimed 
all of the GST credits you are legally able to claim. 

 

3. Ensure that prior to processing your year-end that you have done 2 separate and reliable 
backups of your data. If you change any information after the backups and prior to 
processing the year-end then redo the backups. Store these backups in a safe place and 
take at least one copy off site for added protection of your data.  

 

4. Make sure that no other user is in the system and that no other tasks on your computer 
are in any other AM-Win module such as History or Bank Rec during the year end process. 

 

5. Make sure you have not processed transactions immediately before doing the year-end. If 
you are unsure then exit AM-Win and restart AM-Win and do the year-end. Do not do 
transactions and then go immediately to the year-end process.  

 

6. After the year-end has been processed exit AM-Win and restart AM-Win to begin the new 
financial year. Remember not to print your reports until all transactions for the previous 
year have been processed.  

 

7. Have a coffee / tea / beer / scotch / champagne / wine  
(Whatever you fancy, or all of the above) 
You have done well. Congratulations.  
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*Our valued customers are reminded that the following support call back guidelines 
are currently in place under all current support agreements. 

 

Our support office endeavours to attend to your call as soon as possibly practicable and our staff always make every effort to 
maintain a high level of support to all of our customers every day. Under the current support agreement these are our support 
obligations:  

AM-WIN PRODUCT SUPPORT  
AM-Win and ICS is only obligated to provide Maintenance for any version of the AM-Win Software until the earlier of:  

(i) eighteen (18) months from that version’s release or  
(ii) the release of a second subsequent Major Product Update (for example, until the release of version 11 if you have version 10).  

 
 AM-WIN HOTLINE SUPPORT to the customer is provided as long as the customer is currently up to date with their annual or 
monthly AM-Win Hotline Support Agreement charges. This excludes public holidays and the Christmas - New Year holiday period. 
Outside these hours’ help is available on a best endeavour basis. The customer may use telephone Hotline Support on the nominated 
hotline numbers during the hours of 8.00am and 5.00pm AEST on weekdays and will normally receive a response to their call within 
the following periods. 

1. Four working hours for calls whereby the user is not able to access the data or AM-Win program or any associated programs 
written by AM-Win Software as a result of data corruption or program error.  
 

2. Six working hours for calls that involve a significant restriction of the use of the software, an error restricting access to 
certain records as opposed to the data as a whole or a program fault which causes data to be recorded incorrectly. Issues of 
an urgent nature that requires same day attention to rectify software issues, data errors or system bugs.  
 

3. Two working days for calls that are of a general nature requiring help on how to use certain functionality of the software, 
calls whereby the customer is able to use a workaround or calls where the customers have not received training on the 
areas for which the call relates to. Any non-urgent enquiries or general support calls.  
 

While we specify the times above, we expect that in most cases response times will be much quicker.  

Response Time is defined as the time between receipt of the call and the time that an ICS Team member begins working on the 
problem. Due to the wide diversity of problems that can occur, and the methods needed to resolve them, response time IS NOT 
defined as the time between the receipt of a call and problem resolution.  

We do not offer telephone support during public holidays, weekends or outside of usual business hours. We also have certain times 
throughout the year during which support is either unavailable or diminished due to national conferences and staff training events or 
some events such as Christmas parties. Customers will be notified of these times via email. We usually close for 7 – 8 business days 
over the Christmas / New Year period at which time general support is not available. 

During times when support is not readily available, our staff regularly check emails, phone messages and will offer assistance for 
urgent and severe issues as soon as possible if the issue is emailed to us.  

Customers not on a valid support agreement will be charged at a rate of $30 + GST per 15 minutes. In all cases response for non-
support contract holders will be within 1 working day. See ICS’s Labour Rates for a full list of our rates. 

PLEASE NOTE: Certain times of year most commonly around the end of financial year and early in the new financial year during the 
months of June and July, we often experience unusual high call volumes and as such response times during this period may be 
longer. In the event that a support staff is not able to respond in the required time, it is recommended that the customer call again 
to ensure quicker support is provided. Customers calling for a second or subsequent time will be given higher priority. Response 
times rely on the client accepting a response by any available support representative even if that particular representative is not fully 
familiar with the problem or the specific module in question. If the client wishes to speak with a specific support representative, then 
response times may be considerably longer.  

It is the user’s responsibility to back up their data and to ensure that the backup is operating correctly, the backup data is valid and 
the backup data is safely stored. If the user does not have recent and valid backups, then this will greatly reduce the ability for 
either AM-Win or ICS to support the customer.  

*Support is only available for products supplied by,  
written by or manufactured by either AM-Win software or ICS. 

 

http://www.icsjet.com.au/Sources/Resources/ICS%20LABOUR%20RATES%20Mar%20'20.pdf
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